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1 About Auto Attendant 
Auto Attendant provides a professional first impression for your callers. It is a flexible, powerful, front 

office tool that automatically answers incoming calls with a customized greeting and menu messages to 

direct the caller to the right person or department. 

1.1 Benefits 
Flexible Routing Options 

Route multiple incoming numbers to a single point destination, and callers can access common or 

custom menus with the touch of a button. 
 

Flexible Greetings 

Change your greeting or create schedules any time through the Auto Attendant Admin User Portal. 
 

Professional Greeting for Small Companies  

Even the smallest company, or a “virtual” company with no physical office, can present a professional, 

“big company” image to callers, routing calls to employees who are geographically distributed, or to 

mobile employees without fixed-line phones. 
 

Simple Menu and Customization  

Create as many sub-menus as you need and update them as often as you would like. 
 

Savings 

An Auto Attendant can replace or assist an operator by automating incoming phone calls. It does not 

require huge capital investments or maintenance fees. 
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2 Accessing the Auto Attendant Admin Portal 
The following steps will guide you through access the Auto Attendant Administrative Portal. 

1. Start a Web browser and enter the following address: 

https://msgcollab.epiphanyic.com/aaAdmin/aaAdmin.do 
 

Note:  If using Internet Explorer 10 and newer, you should use compatibility mode to access the 

Auto Attendant Portal. 

 
2. Enter your credentials into the Account and PIN fields. 

 The Account is the 10-digit phone number the auto attendant is assigned to. 

 Telesystem will provide the default PIN to your system administrator.  If you need this PIN 

reset or changed please contact a customer service representative.  
 

3. Click the Login to proceed.  

  

https://msgcollab.epiphanyic.com/aaAdmin/aaAdmin.do


                                                                                     Auto Attendant 
 

5 | P a g e  
 

3 Auto Attendant Admin Portal Interface 
Upon log in, you will be presented with the Menu Summary page.  

 

1 Navigation Bar Links that allow you to navigate through the available pages in the Auto 
Attendant Admin Portal.  The navigation bar contains the following 
options: 

 Menu Summary:  Select this option to display the list of Auto 
Attendant menus. 

 Schedule Summary:  Select this option to setup schedules for Auto 
Attendant menus. 

 Dial By Name Directory:  Select this option to create, modify, and 
delete subscriber and access accounts.  If user information needs to 
be changed in the Dial By Name Directory please contact customer 
support. 

 Logout:  Select this option to exit the Auto Attendant Admin portal.  

2 Login Information Indicates the current logged in user and Auto Attendant being 
administered.  

3 Current Page Title Indicates which page in the Auto Attendant Admin portal you are 
currently accessing. 

4 Current Active Menu Indicates what menu is currently being played to callers by the Auto 
Attendant.  As changes are made this updates in real-time.  

 

  

1 2 
3 4 

5675551234 
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4 Auto Attendant Menus 
Use the Auto Attendant Administrator portal to create the call flow menus for an Auto Attendant.   An 

Auto Attendant includes a set of menus linked together.  Each menu represents what a caller may do at 

any specific point in time.  When you create a menu, you specify its purpose and define the actions that 

occur when the caller presses a key on the phone keypad or when a specific event occurs.  For some 

action types, you may specify the prompt that plays.  Use the procedure below to create a new Auto 

Attendant call flow menu. 

To help you get started using Auto Attendant with minimum setup, the Auto Attendant includes sample 

menus that provide basic functionality, including the ability to transfer to a subscriber’s telephone 

number or extension, perform a name directory search, transfer calls to the operator, and select the 

language in which callers hear prompts.  You may modify the sample menus, but you cannot delete 

them from the system.  

You can easily create a menu with a call flow similar to a sample menu or other existing menu by 

creating a clone of an existing menu. 

4.1 Creating an Auto Attendant Menu 
The following steps will provide you with instructions on creating a new call flow menu for an Auto 

Attendant. 

1. Select Menu Summary in the Auto Attendant Navigation Bar. The Menu Summary page opens. 

 

  

5675551234 
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2. Click the New button located at the bottom of the Menu Summary.  The Create New Menu page 

opens. 

 
3. In the Menu Name field, enter a descriptive name for the menu.  

Note:  The name cannot contain spaces or special characters other than the underscore, and should 

describe the purpose of the menu.  
 

4. Select the Menu Type for the menu you are creating. Depending on the type of menu you specify, 

you will be able to select different events or digits.  

 Generic: Allows the administrator to assign keys to actions, other menus, or to play 

prompts. 

 Validate Extension: Provides the same functionality as the Generic Menu and allows the 

caller to dial the extension number of the individual account. Auto Attendant validates the 

extension and transfers the caller to the appropriate account. 

 Name Search: Provides the same functionality as the Generic Menu and allows the caller to 

search for an account by first name or last name. 

 Review: Lists matches found in a Name Search by playing name announcements. The name 

announcements are the recorded names that individual user must setup in their own 

voicemail system in order to have an audio file available for the Auto Attendant. 

 Language Selection: Provides the same functionality as a Generic Menu and allows the 

caller select the language in which prompts play.  

Note: Customers will be responsible for providing the audio files for the prompts.  
 

5. Optionally, enter a description of the menu’s purpose.  This description will display on the Menu 

Summary page and serves as a way to quickly identify a menu. Suggestions include annotating 

which menu is the default menu, or adding the script for a menu prompt for quick identification and 

updating. 

5675551234 
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6. Click the Save button to keep the changes you have made and move on to the Modify Menu page. 

 
 

7. In the top portion of the page, enter the following parameters: 

Parameter Description Menu Type 

Menu 
Prompt 

Specify the name of the prompt file that plays.  To choose a 
prompt that is included with Auto Attendant or has already 
been uploaded to the system; click the select link next to the 
field. Scroll down the list of prompts to find your selection and 
click the prompt’s name to insert it in the Menu Prompt field. 
If you plan to upload a new prompt, click the Choose File 
button then use your computer’s file system to locate the 
compatible .WAV file. Ensure the file name contains no spaces 
or special characters other than the underscore, and then 
choose or open it. Click the Upload button to add the file to 
the system.  If the file name already exists you will be 
prompted that you are about to overwrite an existing file.  If 
you proceed, the existing file will be removed from the system 
and is not recoverable.   

All Menus 

5675551234 
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Parameter Description Menu Type 

Description 
Description of the menu’s purpose.  This may already be 
populated if you entered a description on the previous screen. 

All Menus 

Search 
Criteria 

Specify whether the caller may search for the subscriber by 
first name or by last name when they dial into the system. 

Name Search 

Menu Type 

Displays the type of menu:  

 Name Search 

 Generic 

 Review 

 Validate Extension 

 Language Selection 

All Menus 

Input 
Timeout 

The number of seconds the caller has to start entering digits on 
a touchtone phone.  If the caller does not enter a digit within 
the specified period, the system times out and the call is 
processed according to the Timeout Action Type on the Events 
tab. 

All Menus 

Max 
Timeout 
Count 

The number of times the caller can reach the Input Timeout 
before the system process the call according to the Max 
Timeout Action Type on the Events tab.  

All Menus 

Max Error 
Count 

The number of errors the caller can make when entering digits 
on a touchtone phone before the system processes according 
to the Max Error action type on the Events tab. 

All Menus 

Barge In 
If selected, a caller can enter digits on a touchtone phone while 
a prompt is still playing.  The Dual-tone multi-frequency 
(DTMF) input interrupts the prompt. 

All Menus 

Error Barge 
In 

If selected, a caller can enter digits on a touchtone phone while 
a prompt plays after the caller has committed an error. 

All Menus 

Search 
Limit 

The maximum number of matches the system plays after the 
caller enters letters in the subscriber’s last name. 

Name Search 
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8. In the lower portion of the Modify Menu page, define the action to occur as a result of any single 

DTMF digit (on the Digits tab) or event (on the Events tab).  

 

Digits Tab 

 
 

Events Tab 

 
 

Action Types 

Parameter Description Menu Type 

Backward The system plays the previous match when the caller presses 
the specified DTMF digit or when the specified event occurs. 

Review 

Direct 
Transfer 

The caller transfers to a subscriber’s extension when they press 
the specified DTMF key. When you select Direct Transfer, a 
Name Directory page lists users in the organization.  Select the 
check box next to the subscriber you want callers transferred to 
and click Select.  The Action Target updates with the 
subscriber’s dial number.  

All Menus 

Dynamic 
Transfer 

The caller transfers to the extension entered on the phone 
keypad. This action type is only available for Unique Match and 
Valid Extension events.  

All Menus 
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Parameter Description Menu Type 

External 
Transfer 

The caller transfers directly to an external address when they 
press the specified DTMF key.  When you select External 
Transfer, a Transfer Number page opens.  Select SIP Address or 
Telephone Number in the drop-down list, enter the 
appropriate value in the text box, and click Select.  The Action 
Target field automatically updates. 

All Menus 

Forward The system plays the next match when the caller presses the 
specified DTMF key or when the specified event occurs. 

Review 

Goto Dialog Links a caller to another Auto Attendant menu.  When you 
select Goto Dialog, a Menu Selection page lists existing Auto 
Attendant menus.  Select the check box next to the menu that 
you want the caller to hear and click Select.  You can also create 
a new menu by clicking the New button on the Menu Selection 
page.  The Action Target field updates with the menu name. 

All Menus 

None No action target is configured.  When a caller presses the 
specified DTMF key an Error occurs.  

All Menus 

Operator 
Transfer 

The caller transfers to the operator when they press the 
specified DTMF key.  When you select Operator Transfer, the 
Action Target is set to the organization Operator Transfer 
Number defined by the service provider.  To change this, please 
contact customer support. 

All Menus 

Reprompt Replays the entry prompt for the current menu. All Menus 

Select 
Language 

The caller can select the language in which prompts play when 
they press the specified DTMF key.  When you choose the 
Select Language option, the Action Target provides a list of 
languages available on the system. 

Language 
Selection 

Start The system starts playing the list of matches when the caller 
presses the specified DTMF digit or when the specified event 
occurs. 

Review 

Voicemail 
Transfer 

Sends a caller directly to a Voicemail account’s mailbox 
greeting.  When you select Voicemail Transfer, a Name 
Directory page lists existing Auto Attendant accounts.  Select 
the check box next to the name of the account that wants this 
service and click Select.  The Action Target updates with the 
dial number.  

All Menus 

 

 

 

 

 

 

 

 



                                                                                     Auto Attendant 
 

12 | P a g e  
 

9. If you select an action type and want to play a prompt to the caller, use the following method to 

select the prompt to play: 

 Click the select link in the row.  A prompt selection page similar to this page opens: 

 
 

 Click the Play button to listen to a prompt using your browser’s default media player. 

 Click on the prompt’s name to select it and assign it to the action. 

 Proceed to step 11. 
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10. To upload a pre-recorded .wav file, use the following method: 

 Click the select link in the row.  A prompt selection page similar to the following opens: 

 

 

 

 

 

 

 

 

 

 

 

 Click the Choose File button and use the computers file system to locate the .wav file you 

want to add to the system.  Ensure that the file name contains no spaces and no special 

characters other than the underscore. 

 Click the Upload button.  The system uploads the .wav file to the Prompt Selection menu 

and assigns it as the active prompt for the action.  

The following example shows prompts specified for the Operator Transfer, Direct Transfer, and 

Disconnect Action Types.  

Note:  The Reprompt does not receive a prompt because it plays the main Menu Prompt by default.  

 

11. Click the Save button to keep your changes.  
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4.2 Cloning an Auto Attendant Menu 
A simple alternative way to create a menu is by creating a clone or copy of a menu that is already 

defined.  Cloning allows you to change only the parts of the menu that you want without having to start 

from scratch. 

To Clone a Menu: 

1. Select Menu Summary in the Auto Attendant Admin navigation bar.  The Menu Summary Page 

Opens. 

 
 

2. Click on the name of the menu you wish to clone.  The Modify Menu page opens, similar to the 

following: 

 



                                                                                     Auto Attendant 
 

15 | P a g e  
 

3. Click the Clone button located at the bottom of the Modify Menu page.  The Clone Menu page 

opens. 

 
4. In the Name field, enter a name for the new menu.  The name cannot contain any spaces or special 

characters other than the underscore, and should describe the purpose of the menu. 

5. Perform steps 8 through 11 in the section of this guide labeled 4.1 Creating an Auto Attendant 

Menu.  
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5 Creating a Schedule 
After you create the menus for an Auto Attendant, you can setup the menus to play based on a specific 

schedule (such as business hours, non-business hours, holidays, and so on).  The schedule determines 

the prompts callers hear and when the prompts play.  For example, if you create a lunchtime menu, you 

can create a corresponding schedule that plays a certain greeting to callers during the lunch hour. 

Before you create a schedule, create the menus to include in the Auto Attendant, as described in section 

4.1 Creating an Auto Attendant Menu.  

For each schedule, you can define the following:  

 First schedule instance:  You can define the start date/time and end date/time for the first 

instance of the schedule.  For example, you can define a weekend schedule that starts on Friday, 

November 29 at 5PM and ends on Monday, December 2 at 8AM.  

 Recurrence Patter:  From the first instance, you can choose a pattern by which the instance 

recurs.  The recurrence patterns include daily, weekly, monthly, and yearly.  You can also 

choose to have the recurrence continue indefinitely or specify an end date. For example, you 

can set up the weekend schedule defined above to recur every weekend by selecting the weekly 

recurrence option. 

 Precedence:  The precedence allows for multiple schedules that overlap.  During the 

overlapping period, the system plays the menu from the schedule with the highest precedence. 

5.1 Creating a Schedule 
Follow these steps to create a schedule that will determine when a menu will play. 

1. Select Schedule Summary in the Auto Attendant Navigation Bar. 

2. Click the New button to create a new schedule. The Create Schedule page opens. 
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3. In the Name field, enter a descriptive schedule name.  The schedule name cannot contain 

spaces or special characters other than the underscore. 

4. In the Precedence drop-down list, select the level of precedence for the schedule.  If more than 

one schedule is set to run at the same time, the schedule with the higher precedence plays. 

Valid values are: Lowest, Low, Medium, High, and Highest.  

5. Optionally, enter a description of the schedule.  For example, Message to be played during lunch 

hour. 

6. Specify the duration of the schedule in the Start Time, End Time, Start Date, and End Date 

fields.  

 
 

7. Click the Create Recurrence Pattern button and configure how often this schedule should 

happen.  The recurrence patterns include None, Daily, Weekly, Monthly, and Yearly.  To create a 

recurrence pattern: 

a. In the Time Duration fields, select the start and end time.  

 
b. Specify when the schedule should recur (None, Daily, Weekly, Monthly, or Yearly). 

When you select an option, the choices change. 

Recurrence Pattern Options 

None No additional options.  The schedule will occur on the Start Date 
at the scheduled Start Time and play until the End Date/End Time 
are met and then never play again unless modified. 

Daily Every n day(s):  Enter a value to define how often the schedule 
runs, or choose Every weekday which will activate the schedule 
Monday through Friday. 

Monthly Day date of every m month:  Enter the day of the month the 
schedule will run on, and the number of months. 

Weekly Recur every n week(s) on:  Enter a value to define how often the 
schedule will run, and select the days (Sunday through Saturday) 
the schedule runs. 

Yearly Every month date:  Select a month, and enter a day for which the 
schedule should recur. 
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c. Specify whether the recurrence continues indefinitely or specify an end date.  In the 

Range of recurrence section, enter:  

i. Start Date: Date when recurring schedule begins. 

ii. No end date:  Select this if the schedule is not limited. 

iii. End by: The schedule ends on a specific date.  

 

d. Click the Save button.  The Create Schedule page displays a summary of the recurrence 

pattern, similar to the following: 

 
8. To select the menus callers will hear during the scheduled time, click the Add Menu to Schedule 

button.  The Select Menu Step 1 of 2 page displays a list of available menus. 
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9. Select the menu that you want to play during this schedule by placing a check the select column, 

and then click the Next button.  You may also preview the menu by click on the menu name to 

view the options configured for the menu.  Once you choose a menu you will proceed to the 

Select Menu Step 2 of 2 page.  It also displays a list of menus.  

 
 

10. Select the menu that your original selection will override.  This should be the default menu.  For 

many companies the default menu is the closed menu.  Select the menu by placing a check in 

the column for the default menu and then click the Next button.  The Create Schedule page 

opens and shows the names of the menus in the bottoms section. 

 
 

11. Verify the information and click the Save button.  The Schedule Summary page opens.  
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6 Dial by Name Directory 
A Dial by Name directory allows a caller to reach a subscriber by name and then transfer to the 

subscriber’s extension.  The Auto Attendant administrator can enable and disable users from the Dial by 

Name Directory.  Callers can enter the subscriber’s first or last name on a touchtone phone to transfer 

to the individual’s phone. 

To use the Dial by Name Directory, the subscriber account must already exist, and the Subscriber Auto 

Attendant service must be active for the subscriber account. 

To Enable or Disable a User in the Dial By Name Directory: 

1. Select Dial By Name Directory in the Auto Attendant Navigation Bar.  The Dial By Name 

Directory page opens.  The directory lists accounts in the organization that owns the access 

account. 

 
 

2. Select the people to include in the Dial By Name Directory: 

 Select the check box next to individual accounts 

Or 

 Click the Enable All button to include all names 

Or 

 To exclude names from the directory, clear the check box next to individual names or 

click the Disable All button to clear the check box next to all names. 

 

3. Click the Save button to keep your changes.  

  

All available phone 
numbers are listed 
here individually. 
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7 Prompt Recording Studio 
The Prompt Recording Studio application allows administrators to record custom prompts and name 

announcements.  The Prompt Recording Studio application gathers custom prompts entered in the Auto 

Attendant menu as file names.  Once the custom prompts are available, you can use the Auto Attendant 

Admin Graphical User Interface (GUI) to upload them for use in Auto Attendant menus. 

Ensure the name of any prompt file that you add to the Auto Attendant call flow contains only digits (for 

example, 111.wav, 20.wav), not alphabetic characters.  If a prompt file name contains alphabetic 

characters (for example, test.wav, myprompt.wav), the Prompt Recording Studio plays “unreadable 

filename” when listing the prompt names to select for recording.  

7.1 Accessing Prompt Recording Studio 
There are two ways to access the Prompt Recording Studio application: 

 Dial the Prompt Recording Studio access number. 

 Dial the Auto Attendant access number and then press *6 when the Auto Attendant greeting 

begins. 

7.1.1 Dialing Prompt Recording Studio Access Number 

To access Prompt Recording Studio by dialing the Prompt Record access number: 

1. Dial the Prompt Recording Studio access number.  

The following prompt plays: 

“Hello and welcome to the Prompt Recording Studio.” 

2. When prompted to enter your account number, enter the Auto Attendant access number and 

press #. 

3. When prompted for your PIN, enter the Auto Attendant access number PIN.  This is the same 

PIN used to access the Auto Attendant Admin Portal. 
 

The system offers the following options: 

Key Task 

1 Record new prompts 

2 Review all prompts. 

3 Record a specific prompt. 

4 Record name announcements for each Auto Attendant subscriber. 

* Exit. 

 

7.1.2 Dialing Auto Attendant Access Number 

To access Prompt Recording Studio by dialing the Auto Attendant access number: 

1. Dial the Auto Attendant access number. 

2. While listening to the first menu, press *6. 
 

The following prompt plays: 

“Hello and welcome to the Prompt Recording Studio.” 
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3. When prompted for your PIN, enter the Auto Attendant access number PIN.  This is the same 

PIN used to access the Auto Attendant Admin Portal. 

The system offers the following options: 

Key Task 

1 Record new prompts. 

2 Review all prompts. 

3 Record a specific prompt. 

4 Record name announcements for each Auto Attendant subscriber. 

* Exit. 

7.2 Recording New Prompts 
In an Auto Attendant menu, new prompts are prompts that have not been recorded.  When you create 

or modify a menu in the Auto Attendant Admin Portal, you can enter the name of a prompt that does 

not exist.  After you enter the new prompt name and save it into a menu, you can use Prompt Recording 

Studio to record the new prompt.  After you record and save a new prompt, you can use the Review all 

Prompts option to make changes.  

If your system does not have Text to Speech (TTS), make sure the name of any prompt file that you add 

to the Auto Attendant call flow contains digits (for example, 111.wav, 20.wav), not alphabetic 

characters.  If a prompt file name contains alphabetic characters (for example, test.wav, 

myprompt.wav), the Prompt Recording Studio plays “unreadable filename” when listing the prompt 

names to select for recording. 

Before recording new prompts, use the Auto Attendant Admin Portal to specify a prompt file that is not 

currently used in a menu.  For more information, see section 4.1 Creating an Auto Attendant Menu.  

To Record a New Prompt: 

1. Access the Prompt Recording Studio. 

2. On the main menu, press 1 to record new prompts.  

3. Prompt Recording Studio plays the list of prompt file names and instructs you how to proceed 

when you hear the prompt you want to record.   
 

The following options are available: 

Key Task 

1 Re-play the list of prompts. 

2 Re-play the previous prompt. 

3 Skip to the next prompt. 

# Continue with prompt recording. 

* Return to the main menu. 

 

4. When you hear the prompt you want to record, press #.  The system plays the new prompt file 

name to record, then plays the following instructions:  please record this prompt after the 

beep.  When finished, press the # key. 
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5. Record the prompt and press #.  

The system offers the following options: 

Key Task 

1 Review the recorded prompt. 

2 Re-record the prompt. 

3 Save the prompt. 

* Cancel. 
 

6. When you are satisfied with the recording, press 3 to save.  Prompt Recording Studio then plays 

the main menu.  

7.3 Reviewing Prompts 
In an Auto Attendant menu, all prompts refers to the set of prompts in an organization’s call flow, 

whether or not the prompts have been recorded.  When creating menus for a call flow, you can use 

Prompt Recording Studio to review and re-record any prompt specified as a Menu Prompt, DTMF list, or 

event list. 

If your system does not have Text to Speech (TTS) and prompt file names contain alphabetic characters 

(for example, test.wav, myprompt.wav), Prompt Recording Studio plays “unreadable file name” when 

reviewing prompts. 

To Review and Re-record Prompts: 

1. Access the Prompt Recording Studio. 

2. On the main menu, press 2 to review all prompts. 

3. Prompt Recording Studio plays the list of prompt file names and instructs you how to proceed 

when you hear the prompt you want to modify.  
 

The following options are available: 

Key Task 

1 Re-play the list of prompts. 

2 Re-play the previous prompt. 

3 Skip to the next prompt. 

# Continue with prompt recording. 

* Return to the main menu. 
 

4. When you hear the prompt you want to modify, press #. 

The system offers the following options: 

Key Task 

1 Review the current prompt. 

2 Record the current prompt. 

3 Delete the prompt. 

* Cancel. 
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5. Press 2 to record the prompt, and press #.  
 

The system plays the following instructions: 

“Please record this prompt after the beep.” 
 

6. Record the prompt and press #. 

The system offers the following options: 

Key Task 

1 Review the recorded prompt. 

2 Re-record the prompt. 

3 Save the prompt. 

* Cancel. 
 

7. When you are satisfied with the recording, press 3 to save.  Prompt Recording Studio plays the 

main menu. 

7.4 Recording Name Announcements 
Auto Attendant uses name announcements for transfer confirmations and Dial By Name selection.  You 

can record name announcements using the Prompt Recording Studio.  

To Record a Name Announcement: 

1. Access the Prompt Recording Studio. 

2. At the main menu, press 4 to record name announcements. 

3. When prompted, enter a valid user account number and press #. 

4. After the beep, record the name announcement and press #. 

5. Press 3 to save. 
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8 Record Prompts Using Voicemail 
If you have a voicemail box, you can use it to record new prompts for you Auto Attendant system.  This 

is done by configuring the voicemail box to send you an email attachment of messages that are left in 

your voicemail box.  The attachment is already in the .wav format needed for the Auto Attendant 

system.  Save the attachment to your computer, rename it, and then upload it to the Auto Attendant 

Admin Portal.  

The following steps will assist you with configuring the Voicemail Email Notification: 

1. Access the Voicemail Portal at https://msgcollab.epiphanyic.com/VXView/VXView.do 

 
 

2. Enter your credentials in the Account and PIN fields: 

 The Account will be the 10-digit phone number for the voicemail box.  Note that this is 

likely not the same phone number assigned to your Auto Attendant system.  Most Auto 

Attendants do not have an assigned Voicemail service because the system is designed to 

transfer callers to a different number.  

 The PIN will be the same as the access PIN used to check your voicemail messages when 

you call in to hear your voicemail messages. 
 

3. Click on Notification from the Navigation Bar on the left hand side of the screen.  Then click on 

the Set Up Notification link. 

 
 

https://msgcollab.epiphanyic.com/VXView/VXView.do
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4. Enter the destination email address when you want your messages delivered in the Email 

Address field.  Then click the Add Attachment button.  The email address will then appear in the 

Email Address List window followed by “(attachment)”, indicating that email address will 

receive and message when a voicemail message is left and the message will be attached to the 

email as a .wav attachment.   

 
Note:  If you select Add, you will still receive an email notification when a voicemail is left, but it 

will not include the .wav attachment. 
 

5. Click the Save button at the bottom of the page to keep your changes.  
 

6. You will receive a Confirmation screen.  Click on the notification settings link to return to the 

Notification menu. 

 

 

 

 

 

7. Now, click the Activate Notification link.  
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8. Ensure that the Notify me through Email option is set to “Every time I receive a message”. 

 
 

9. Click the Save button at the bottom of the page to keep your changes.  

10. Call into your voicemail box.  When prompted leave your message.  When leaving the message 

only say what you wish for your Auto Attendant prompt to play to your callers unless you plan 

to edit the audio file yourself.  

11. When you receive the email with the .wav audio file attachment, save the attachment to your 

computer. 

12. Rename the .wav file, ensuring the new file does not contain any spaces or special characters 

other than the underscore.   

Note:  Keep in mind that once the prompt has been uploaded to the Auto Attendant system the 

file name cannot be changed.  

13. Login to the Auto Attendant Admin Portal . 

14. Select the menu from the Menu Summary page that you wish to use the new prompt with. 

15. Click the Select link for the corresponding prompt. 

16. When the Prompt Selection menu opens, click the Choose File button. Then use your local file 

system to locate and select the .wav file that you save and renamed earlier.  The file name will 

now show next to the Choose File button. 
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17. Click the Upload button to add the new file to the Auto Attendant.  You will return to the 

Modify Menu page.  The file name of the prompt will now show in the Menu Prompt field. 

 
 

18. Make any necessary adjustments to the remainder of the Auto Attendant menu to correspond 

with the dialog in the new prompt.  Click Save to keep your changes.  

 

 

 
 

 




